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1 Getting Started

1.1 What is MindCAD?

MindCAD is a suite of specialist programs that have been developed specifically for shoe design and
manufacturing.

Last Design & Engineering - For input, modification and flattening of lasts.

3D Design & Engineering - Allows lines to be drawn on a last in 3D and 2D. These lines can then
be used to create parts with thickness, and textures. Accessories, punches, holes and padding can
also be added, as well as laces and soles.

The final design can be output to:

2D Design & Engineering - For 2D part creation, grading, cutting and specification

Viewer - This is a free package of visualization software from Mind and can be downloaded from
Mind Technology website.

1.2 Before you begin

IMPORTANTE NOTE: A valid product authorization file must be installed before MindCAD can be
used.

If you’d like some sample data to use in MindCAD Last Design & Engineering:
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1. From the File menu, select Open to load example projects.
2. Select a file and press “Open” (or double click the file).

All instructions in this manual are correct at the time of printing. Some sections may not be up to
date due to subsequent updates to MindCAD LAST Design & Engineering.

1.3 How do I start Last Design & Engineering?

Double click MindCAD Last Design & Engineering´s icon  on your desktop. MindCAD
Last Design & Engineering will start shortly after.

1.4 How do I use the Menus?

 

Almost everything in MindCAD 3D Last Design & Engineering can be accessed through the main
menu. This is shown in the picture above and is displayed at the top of the MindCAD 3D Last
Design & Engineering screen.

1. Select an item from the main menu. A drop down list is displayed, showing a list of sub-items,
each corresponding to specific program action.Greyed out sub-items mean that a specific program
action is not available (e.g. a paste action will not be available if no copy action was previously
executed).
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2. If you move your mouse to an item that has an arrow alongside, as highlighted above, an
additional list of sub-items will appear.
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1.5 Last Design & Engineering Layout

The image below shows MindCAD 3D Last Design & Engineering's interface.

1. Menu Bar - Most of MindCAD 3D Last Design & Engineering’s functionality may be accessed
through this menu.

2. Main Bar - This toolbar allows a user to open a new project or an existing one, save a project,
print, cut, copy, paste, undo, redo, zoom to fit, go to help topics and open Mind's web site.

3. View Settings - This toolbar allows a user to control the project's visualization settings and save
them.

4. Tabs - Allows a user to switch between sets of projects, as well as close any of them.
5. Tools Bar - This toolbar allows a user to select the draw lines tool, change between work on

upper or bottom surfaces, access several last editing tools, measurement tools and last flattening
interfaces.

6. Status Bar - This toolbar located at the bottom of the document window provides additional
information about the project a user is creating.

7. Views Bar - This toolbar allows a user to change the last's point of view.
8. Line Snap - This toolbar allows a user to control 'snap' editing to the nearest line, nearest

intersection, nearest end or nearest point. 
9. Layers Bar - This toolbar have the options to let you turn on/off the layers of the project.
10.Canvas Area - Allows a user to visualize the last.
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1.6 How do I manipulate the view contents?

There are three main interaction classes for direct manipulation of the 3D environment:

Scaling

Moving (Panning)

Rotating

1.6.1 Scaling

To scale the view, in both 3D and 2D windows,

1. Press the Ctrl key and hold down the middle mouse button. View contents will scale up/down as
the mouse is moved up/down.

2. Releasing the middle mouse button will end the scaling process.

You can also scale by using the mouse scroll wheel.

1.6.2 Moving (Panning)

To move the view contents, in both 3D and 2D windows,

1. Press the Shift key and hold down the middle mouse button. As the cursor is moved, view
contents will move with it.

2. Releasing the middle button will end the process.

1.6.3 Rotating

To rotate view contents, in the 3D window,

1. Hold down the middle mouse button. As the cursor is moved, view contents will rotate.

2. Releasing the middle button will end the process.

1.7 Getting Help with MindCAD 3D Last Design & Engineering

Help in  MindCAD 3D Last Design & Engineering is available in the following ways:

Tool Tips

Status Bar Help
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Standard on-line Help

1.7.1 Tool Tips

Placing the cursor over a button will display a brief description of the function of the button.

1.7.2 Status Bar Help

Placing the cursor over a button will display information about the button in the status bar.

1.7.3 Standard on-line Help

1. Select Help from the MindCAD 3D Last Design & Enigneering's menu.

2. Select Contents and Index and then the item you require. There's a separate section for
each option on the main toolbar.

1.8 Whats New

1.8.1 2016.V1

MindCAD 3D LAST Design & Engineering 2016.V1 release offers the following new features and
enhancements:

Usability and Productivity
Additional reference elements on flattening

Is now possible to draw lines on the 3D insole and on the resulting flattened insole.
Auto apply on Edit Surface

Auto apply option is now available on Edit Surface tool.
Last snapping to 3D stencil

Enhanced modelling tool supporting last adjustment/ snapping to 3D stencil.
Faster activation of top level surfaces

Top level surfaces are now automatically activated. Just press the <Shift> key and left-click over the
required surface

New section template editor
New editor to save and apply section configurations templates.

Edit Last Sections revised interface
Distance from heel/toe" fields are now editable.

Revised labels drawing
Drawing of axis labels has changed for contrasting circles. Cancel and Finish actions were also
included.

New heel symmetry tool 
New modelling tools for heel symmetry adjustment.
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Interoperability
Usage of 3D splines over surface

For enhanced interoperability, extended usage of 3D splines over surface.
Skybox support

Environment mapping and IBL are now unified.
Last Templates export

Export toe and heel templates.

Flattening Features
New Flattenings Manager
New distortion color map 

Distortion map displaying the distortion regions between 2D flattened results and 3D representation.
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2 File Overview

This menu lets you create new files, open existing files, close files and save files. It also lets export
and import data, set your preferences and print.

2.1 File - New

This option allows to open a external file, create a new last from template or from merge.
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2.1.1 File - New - From external format

This is the same as clicking the New Last  button in the Main toolbar or pressing CTRL+N.

Use this option to select a last to import.

You should select the correct file format to be able to browse for your original files. The most
common formats are IGES and STL.
When a last has been used to create a design and is saved, all the information is saved into a
project.

2.1.1.1 File - New - LAS

Open lasts in the LAS file format (Import Last Design & Engineering old format files).

2.1.1.2 File - New - ASC Files (Studio 3D)

Open lasts in the ASC file format. (3DStudio Files). It launches the import wizard after loading,
please refer to Import Wizard for details.

2.1.1.3 File - New - ASC Files (Forma 2000)

Open lasts in the ASC file format (Forma 2000 Files). It launches the import wizard after loading,
please refer to Import Wizard for details.

2.1.1.4 File - New - DMT

Open lasts in the DMT file format (Delcam Machining Triangles Files).  It launches the import
wizard after loading, please refer to Import Wizard for details.

2.1.1.5 File - New - IGES

Open lasts in the IGES file format (Initial Graphics Exchange Specification Files). If the parametric
topology of the file is compliant the last will be seamlessly imported. If not, try importing the file by
using the "File - New - IGES as triangle mesh" option.
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2.1.1.6 File - New - STL

Open lasts in the STL file format (Stereolithography Files).  It launches the import wizard after
loading, please refer to Import Wizard for details.

2.1.1.7 File - New - VRML

Open lasts in the VRML file format. It launches the import wizard after loading, please refer to Import
Wizard for details.

2.1.1.8 File - New - OBJ

Open lasts in the OBJ file format (WaveFront Files). It launches the import wizard after loading,
please refer to Import Wizard for details.

2.1.1.9 File - New - 3DM

Open lasts in the 3DM file format (Rhino Files). It launches the import wizard after loading, please
refer to Import Wizard for details.

2.1.1.10 Import Wizard

Last's that don't comply with the expected topology can still be imported using a wizard. 

After loading the file, the last single surface is displayed and sequence of operations is needed for
successful import

1. mark Toe Point (in the middle of the last shape on the toe)
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2. mark Heel Point (in the middle of the last shape on the heel)

3. mark Top Heel Point (in the middle of the last shape on the top of the heel)
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4. mark Top Front Point (in the middle of the last shape on the top)

5. Check Last Orientation. After Confirm alignment. 

6. Adjust Feather line 
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7. Right click, Move to line adjustment (or Cancel  the Last importation)

8. Its possible to adjust the line easily, to do that press the right button of the mouse and select
Smooth Line.

9. Do a right click, select Finish Line Adjustment (it's also possible to go back to auto-line adjust,
replace a point or cancel importation)
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10. adjust separation (move the red points to define front and rear distribution areas for new mesh
lines)

11. generate mesh (right click and select Generate Fast Grid). 

12. input number of horizontal and vertical lines for mesh generation. The number of assigned lines
must change according to last complexity (ie. 30 horizontal and 30 vertical are typical reference
values).
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13. using right click, the grid could be confirmed or discarded. If discarded then the process returns
to point 7

14. In this step, fine adjustment of grid points is possible by simply dragging the hover red point to
the desired location. 

 

Doing a right click and selecting, on the context menu, the options to Add/Remove Row/Column,
will insert a new grid line on the red point. To proceed, do a right click and choose Confirm Grid.
Going back in the import process is possible by choosing Cancel Grid.
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15. In this step, it's possible to check the difference between the original surface and the imported
surface. 

To proceed, do a right click and choose Confirm Surface. Going back in the import process is
possible by choosing Cancel Surface.
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16. if confirmed, a last with the generated mesh is created.

2.1.2 File - New - From template

This allows to create a new last from a template last. 

Select the template file, select the new size, insert the Key to be used; the Age, between Child,
Teen or Adult and insert the Heel Height in mm.

Press Ok and the new Last will be generated. 
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You can see an example bellow, a geometric construction, based in size 37, key 7 and heel height
6.

Note: The above diagram does not depict an actual Last Design & Engineering interface.
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2.1.3 File - New - From merging

This option allows to merge two different last's. 

1. Press Browse to open the require Last's, from PDM or from file. 
2. The opened last will be visible in the Available lasts field. 

3. Select the Last A  and B from the available lasts, by clicking over the last name. 
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4. Select the New last Name, Side, Number, Increase By Number in length and around the girth in
mm

5. Press Ok and the new last will be generated.

Doing a right click the following context menu will appear:

Allowing to edit the last's merge finish or cancel de merge. 
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2.1.3.1 Define cutting planes

Rotate the last for a better plan. Now you can change the cutting planes. 

To edit the Last cutting planes; Its possible to move the plane parallel or move just one of the plane
ends.
Note: The cutting plane will always move over the original last lines. Red plane over the Last A lines
and the Green plan over the Last B lines. 

To move the plan parallel: 
1 - Move the mouse cursor over the cutting plane 2 - Click and drag the cutting plane

3 - Release the line and the new merging area
appears 

To move one of the plane ends:
1 - Move the mouse cursor over one of the cutting
plane ends

2 - Click and drag the cutting plane end

Move the mouse cursor over one of the cutting planes and do a right click the following context
menu will appear:
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To make the planes parallel again select the option Make planes parallel.

2.1.3.2 Move surfaces

Do a right click, and select Move surfaces from the contextual menu. 

It's possible to move the surfaces in an x,y axis (right/left and top/bottom). 
Note: The movement is related to the last point of view.

To move the surface, place the mouse cursor over the surface, click and drag to the desired
direction. 
Press SHIFT to change the direction. 
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Lateral View

Or over the surface handles, shown in the top or lateral of the work area. 
top handle - movement rigth to lef lateral handle - movement top to bottom.

Top View
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Place the mouse cursor over the surface. Press Shift to change the movement direction.

Or use the handles to move the surface

Front View

Press shift to change the movement direction or use the handles.
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2.1.3.3 Rotate surfaces

Do a right click, and select Rotate surfaces from the contextual menu. 

There are two rotations possible, right to left or top to bottom. Depending in the last point of view. 

Medial or lateral point of view
Click and drag the dialer to the desired rotation.  A feedback of the angle is provided.

Front View
Click and drag the dialer to the desired rotation.  A feedback of the angle is provided.
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2.2 File - Open

This is the same as clicking the Open Last  button in the Main toolbar or pressing Ctrl+O.

Use this option to open any of your lasts from a central database.

Insert the server, user and password and press Ok.

The follow window will appear.
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To open a file from pdm, select the desired one and select Open.
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To open a stand alone file, select the Open from file button and select the file to open.

2.3 File - Close

This is the same as clicking the X button in the corner of any window.
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Use this option to close the current last.

2.4 File - Save

This is the same as clicking the Save Last  button in the Main toolbar or pressing Ctrl+S.

Use this option to save the current last with the current name to a central database. (L3D Format)

2.5 File - Save as

Use this option to save the current last with a new name (L3D Format).

This option allows you to save the current project in a different store and with a different name.

2.6 File - Import

The import menu has different options enabled, depending on which window is active.

2.6.1 File - Import - from Generic 3D

Use this option to import curve geometry from an IGES file.

1. Open file (IGS, IGES..)
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2. Import Iges file (curves)

2.7 File - Export

Use this option to export the current last to other software packages.

2.7.1 File - Export - to Generic 3D

This option let you export the last to a Generic 3D format.

Select between IGES or Waverofront (OBJ) format.
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2.8 Search similar last

Use a search engine to find lasts similar to the current one.
The search is made in the current loaded data base. 

Check/Uncheck the parameters to be considered by the search engine.

Each parameter is configurable. 

Press Ok to start the search, or Cancel to close. 
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The result will appear in the Open window. 
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2.9 File - Preferences...

Use these options to define the properties of such things as your directories, colours and language.
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2.9.1 File - Preferences - Folders

Use these options to set your preferred directories.

Lasts path
Where lasts are stored. Select the directory by using the  Browse button.

Last 2D Templates path
Where the last 2D templates are stored. Select the directory by using the  Browse button.

Texture path
Where textures are stored. Select the directory by using the  Browse button.



47File Overview

© 2016 Mind - Software Multimedia e Industrial, SA

2.9.2 File - Preferences - Editing

 

Reference elements

Preferred colour and thickness for the reference elements.

Lasts

Preferred flattening method, default and imported material. 

Grid Lines

Preferred colour and thickness for the grid lines.
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2.9.2.1 Mixing Colors

This dialogue box lets you mix single colors. 

2.9.2.2 Selecting colors

1. Use the square to select the color required.

Place the cursor in the square, hold down the left mouse button and move it to the color required.
Releasing the mouse button to complete the operation.

Other way to select the color is to press the Select Button 

Move the mouse over the colors, to select the color do a left click over it.
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The new color will be displayed next to the current (original) color so you can see the changes.

2. Use the lateral bar to select the shade of colour; use the left mouse button as before.

2.9.2.3 Using values to change colours

During the colour selection process the values of the current colour will also be displayed.

These values can be changed by using the up and down arrows next to the value or by entering a
new value in the relevant box.



50 MindCAD - Last Design & Engineering

© 2016 Mind - Software Multimedia e Industrial, SA

2.9.3 File - Preferences - Display

Use these options to set your preferred language, flattening version and automatic girth line
generation.

Interface 

Language - Select your preferred language from the Language drop down list.

Application Theme - Select the application theme using the browse button .

There are four options available.

Monitor horizontal size (mm) - Tick User defined Horizontal width of the monitor to specify
the dimensions of your monitor.

Auto center view when zooming - Enable/disable auto centring the graphics when zooming.

3D View

Default 3D view settings - Preferred initial 3D view settings.
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Selection Color - Choose the selection color.

Use selection Color on lines - Enable/disable the Selection Color use for the lines.

Selection outline thickness - Choose the thickness in px

Enable high quality time delay - Tick this option to set delay value (ms). To control the delay
between the regular fast visualization mode and the activation of the high quality rendering mode. Set
this value to 0 (zero) if you want to work always in high quality mode.

Maximum number of triangles per OpenGL display list - Choose the maximum number of
triangles.

Automatic "Zoom to Fit" when changing camera view - Enable/disable the zoom to fit option,
when the last point of view is changed. 

2D View

2D background color - Preferred colour for the 2D background where the lines are displayed on.
The background option has one colour that can be set.

Draw quality - Select Fast or Quality mode.
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2.9.4 File - Preferences - Misc

Last reference parameters

Girth Line Method - Select the preferred method for girth line generation.
Use Bottom
Use Upper

Heel Alignment - Select the align method for imported lasts (New - From external format).
Vertical alignment (heel vertical line)            Horizontal alignment (heel base)
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Clear 'Don't show again' flags

Press the clear to reset the option, like the one below. This way the program will ask again the
question, instead of doing what the user select as default.

2.10 File - Print...

This is the same as clicking the Print  button in the Main toolbar.

Use this option to print your images

2.11 File - Print Preview

Use this option to preview your print before sending to the printer.

2.12 File - Printer Setup...

Use this option to select a printer and set it to your requirements.
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2.13 File - file list

Use this option to open a recently used last. The last four last names are displayed for quick
selection.

2.14 File - Exit

Use this option to exit the program.
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3 Edit Overview

This menu lets you carry out some of the editing commands, it also allows you to undo edits that
have been made, and restrict editing of items that are correct.

3.1 Edit - Undo

This option undoes the last editing command.

This is the same as clicking the Undo  button in the main toolbar or pressing Ctrl+Z

3.2 Edit - Redo

This option is under development, and will redo the last Undo command.

This is the same as clicking the Redo  button in the main toolbar or pressing Ctrl+Y
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3.3 Edit - Clipboard

This menu lets you, cut, copy, paste or delete selected objects, it also allows to select all objects or
reverse the current selection. 

3.3.1 Edit - Clipboard - Cut

This option cuts the currently selected items. Cut copies the selected items to the paste buffer, then
deletes the selected items.

This is the same as clicking the Cut  button in the main toolbar or pressing Ctrl+X

3.3.2 Edit - Clipboard - Copy

This option copies the currently selected items into the paste buffer.

This is the same as clicking the Copy  button in the main toolbar or pressing Ctrl+C

3.3.3 Edit - Clipboard - Paste

This option pastes the contents of the paste buffer (filled by cut or copy) into the current window.

This is the same as clicking the Paste  button in the main toolbar or pressing Ctrl+V
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3.3.4 Edit - Clipboard - Delete

This option deletes the currently selected items. This is the same as pressing the delete key on your
keyboard.

3.3.5 Edit - Clipboard - Select All

This option selects all items. This is the same as pressing Ctrl+A

3.3.6 Edit - Clipboard - Reverse

This option allows to reverse the current selection.

3.4 Edit - Grouping

This menu lets you group and ungroup lines.

3.4.1 Edit - Grouping - Group

This option lets you treat a number of lines as a single object. If any line within a group is selected
all the other lines in the group will be selected as well.

1. Select the lines that you wish to make into a group.
2. Select Group from the Grouping options in the Edit Menu

3.4.2 Edit - Grouping - Ungroup

This option lets you return lines within a group to individual lines.

1. Select any line in a group.
2. Select Ungroup from the Grouping options in the Edit Menu
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3.4.3 Edit - Grouping - Ungroup All

This option lets you return all the lines within groups to individual lines.

1. Select Ungroup All from the Grouping options in the Edit Menu.

3.5 Edit - Locking

This menu lets you lock and unlock items.

3.5.1 Edit - Locking - Lock

This lets any selected item to be locked, if an item is locked, it cannot be edited.

1. Select items to be locked.
2. Select Lock from the Locking options in the Edit Menu.

3.5.2 Edit - Locking - Unlock

This lets locked items which cannot be edited become editable again.

1. Select items to be unlocked.
2. Select Unlock from the Locking options in the Edit Menu.

3.5.3 Edit - Locking - Unlock All

This lets all the locked items which cannot be edited become editable again.

1. Select Unlock All from the Locking options in the Edit Menu.

3.6 Edit - Visibility

This menu lets you hide and show items.
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3.6.1 Edit - Visibility - Hide

This option allows to temporarily hide any selected items.

3.6.2 Edit - Visibility - Show all

This menu allows to select which items are supposed to became visible.
It's possible to select between Objects and Lines.

3.7 Edit - Constrains

This menu allows to activate or deactivate the constrains options.

3.7.1 Edit - Constrains - Drag Constrain

This allows to control whether a line(s) can be dragged (moved), rotated or scaled.

When the cursor is over a line(s) and displayed as a cross  it is possible to drag, rotate and

scale the line(s) if Drag Constrain  is OFF.
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4 View Overview

This menu lets you control what is displayed on the screen, you can use it to turn on or off, toolbars
and layers.

4.1 View - Zoom to Fit

This option lets you scale any graphics, so that it fits onto the screen. This is the same as clicking

the Zoom to fit button  in the Main toolbar.

4.2 View - Zoom 1:1

When this option is used, the graphics are scaled to the correct physical dimensions. If Zoom 1:1
doesn't work please go to the File - Preferences - Display and specify the correct value (in mm) of
your monitor.
This is the same as  pressing Ctrl+Shift+D.
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4.3 View - Point of View

This option shows all the options for displaying toolbars.

4.3.1 View - Point of View - Lateral

This is the same as clicking the Lateral  button in the Views toolbar or CTRL+4.

Use this option to view your last from the outside view point.

4.3.2 View - Point of View - Medial

This is the same as clicking the Medial  button in the Views toolbar CTRL+6.

Use this option to view your last from the inside view point.
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4.3.3 View - Point of View - Top

This is the same as clicking the Top  button in the Views toolbar CTRL+5.

Use this option to view your last from the top view point.

4.3.4 View - Point of View - Bottom

This is the same as clicking the Bottom  button in the Views toolbar CTRL+0.

Use this option to view your last from the bottom view point.

4.3.5 View - Point of View - Toe

This is the same as clicking the Toe  button in the Views toolbar CTRL+8.

Use this option to view your last from the toe view point.

4.3.6 View - Point of View - Heel

This is the same as clicking the Heel  button in the Views toolbar CTRL+2.

Use this option to view your last from the heel view point.
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4.3.7 View - Point of View - ¾

This menu allows you to select ¾ views of the last

4.3.7.1 View - Point of View - ¾ - Toe lateral

This is the same as clicking the Toe lateral  button in the Views toolbar CTRL+9.

Use this option to view your last from the outside toe view point.

4.3.7.2 View - Point of View - ¾ - Toe medial

This is the same as clicking the Toe medial  button in the Views toolbar CTRL+7.

Use this option to view your last from the inside toe view point.

4.3.7.3 View - Point of View - ¾ - Heel lateral

This is the same as clicking the Heel lateral  button in the Views toolbar CTRL+3.

Use this option to view your last from the outside heel view point.
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4.3.7.4 View - Point of View - ¾ - Heel medial

This is the same as clicking the Heel medial  button in the Views toolbar CTRL+1.

Use this option to view your last from the inside heel view point.

4.3.8 View - Point of View - Previous

This is the same as clicking the Previous  button in the Views toolbar.

Use this option to go back to your previous view point.

4.4 View - Environment

This menu allows to change between the environments and to edit the current one.
This is the same as changing the environment in View setting selector on the View Settings Bar.

4.5 View - Toolbars

This option shows all the options for displaying toolbars.

To access this menu you can also do a right click over the toolbars area.
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4.5.1 View - Toolbars - Merging Tools

This is the option to turn on/off the merging toolbar. This toolbar is available in the flattening
mode. 

4.5.2 View - Toolbars - Main

This is the option to turn on/off the main toolbar. It is recommended that this menu is displayed at
all times.

4.5.3 View - Toolbars - Line Snap

This is the option to turn on/off the Line Snap toolbar.

4.5.3.1 Line Snap - Nearest Line

Use this option to make all editing and drawing operations snap to the nearest line, when the cursor
is close to it.

This is the same as clicking the Nearest Line button in the Line Snap toolbar
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4.5.3.2 Line Snap - Nearest Intersection

Use this option to make all editing and drawing operations snap to the nearest intersection between
lines, when the cursor is close to it.

This is the same as clicking the Nearest Intersection  button in the Line Snap toolbar

4.5.3.3 Line Snap - Nearest End

Use this option to make all editing and drawing operations snap to the nearest line end, when the
cursor is close to it.

This is the same as clicking the Nearest End  button in the Line Snap toolbar

4.5.3.4 Line Snap - Nearest Point

Use this option to make all editing and drawing operations snap to the nearest point on a line and to
the geometric centre on symmetry shapes when the cursor is close to it.

This is the same as clicking the Nearest Point  button in the Line Snap toolbar 

4.5.3.5 Line Snap - Nearest Grid

Use this option to make all editing and drawing operations snap to the grid when the cursor is close
to it. In addition,

When the cursor is on a grid line, the grid is displayed in blue.
When the cursor is on a grid intersection, grid intersection is displayed in red.

This is the same as clicking the Nearest Grid  button in the Constrain toolbar

4.5.4 View - Toolbars - View Settings

This is the option to turn on/off the View Settings toolbar.

Use this tool bar to control the project setting and save them.
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4.5.4.1 Configure View Setting

Use this option to configure the project setting.

1. The View setting selector  allows you to change between setting previous configured.

2. Click in the Create New Settings button  in the toolbar to create a new project setting.

A dialog is displayed for insert the setting name:

Press Ok and the new configuration is saved. To edit the setting press the button Edit Settings. 

3. Click in the Delete Settings button  in the toolbar to delete settings of the setting selector.

4. Click in the Edit Settings button  in the toolbar to change the settings.

5. Click in the Save Settings button  in the toolbar to save settings changes.

6. Click in the Orthogonal Projection button  in the toolbar to change the projection.
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7.   -  Perspective Projection button allows you to change the perspective, its possible to alter

the angle through the Perspective field of view angle .

8. Click in the Shadows Effect button  in the toolbar to enable or disable the shadows.
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9. Click in the Configure Background button  in the toolbar to to configure 3D - Background.

The dialog Background color is displayed:

Gradient Background - The background is displayed as a graded range of colour between the
Top colour and the Bottom colour 

Sky box - To provide an even more natural look, the user may select to visualize the IBL map as a
sky box around the model. 
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Solid Background - A single color is used for the background;

Image background - The user choose the image file and how to align it on your working area.

10.Click in the Texture Mode button  in the toolbar to enable or disable the texture mode.

11.The Environment mapping image allows you to change the environment image, to supply a
last with indirect lighting.
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4.5.5 View - Toolbars - Stencils

This is the option to turn on/off the Stencils toolbar.

4.5.5.1 View - Toolbars - Tools

This is the option to turn on/off the tools toolbar. It is recommended that this menu is displayed at
all times.

 Select - Enable/disable de selection tool 

 Draw Line - Use this option to draw lines over the last. This is the same as going to the menu
Draw - Line. 

 Work on Upper - Enable/disable the option to work on upper surface. Other way to active the
surface is by pressing the <Shift> key and left-click over the required surface.

 Work on Bottom - Enable/disable the option to work on bottom surface. Other way to active
the surface is by pressing the <Shift> key and left-click over the required surface.

 Deactivate every surface - Disable the option to work on every surface.  

 Resurface last mesh - This option should be used when there is the need to repair wrong
surfacing or when if last surface editing procedures were extreme to the point where the current
patchwork in no longer appropriate for rigorous representation and control. This is the same as going
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to the menu Last - Modify - By Resurface. 

 Recalculate toe line - If by last editing, the area of the Toe Line is affected, there is the need
to recalculate the Toe Line (Girth Line). This process is fully automatic without user intervention. This
is the same as going to the menu Last - References - Recalc Girth. 

 Adjust Centre and Heel Lines - When selecting this option the current front and heel lines
can be adjusted using the mouse. This is the same as going to the menu Last - References - Adjust
Centre and Heel Lines. 

 Change Last by editing sections - This allows to modify the last by sections. This is the
same as going to the menu Last - Modify - By Sections. 

 Change Last Shape -  Allows to edit last shape.This is the same as as going to the menu
Last - Modify - By Shape.

 Adjust Surface Grid - Allows to edit last surface grid. This is the same as as going to the
menu Last - Modify - By Surface.

 Free measurement - This tool take measurements over the last surface without being
restricted to lines. This is the same as as going to the menu Tools - Measurements - Free.

 Line measurement tool - This tool take measurements over along a line. This is the same as
as going to the menu Tools - Measurements - Line.

 Generate boot upper - After activation of this button, a wizard is launched, guiding the
creation of the bootleg. This is the same as as going to the menu Last - Boot Leg - Shell.

 Last Grading - This option lets you create a graded last. This is the same as as going to the
menu Last - Grading.

 Flatten Last Upper - This option lets flatten the upper surface of the last. This is the same as
as going to the menu Last - Flattening - Flatten Last Upper.

 Flatten Last bottom - This option flattens the bottom surface of the last. This option lets
flatten the upper surface of the last. This is the same as as going to the menu Last - Flattening -
Flatten Last Bottom.

4.5.6 View - Toolbars - Adjust Surface Grid

This is the option to turn on/off the Adjust Surface Grid toolbar. This toolbar is active when using
the modify by surface tool. 

4.5.7 View - Toolbars - Views

This is the option to turn on/off the Views toolbar.
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4.5.8 View - Toolbars - Customize

This allows advanced interface customization.

4.5.8.1 View - Toolbars and Docking Windows - Customize - Commands

In the commands tab are available all the program commands, arranged by Categories.
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The user can drag any command to the toolbars.

4.5.8.2 View - Toolbars and Docking Windows - Customize - Toolbars

Use these options to create your own toolbars and to reset the existing ones.

To add a customized toolbar please follow this sequence:

1. On the Toolbars tab, click New

2. Insert the name and press OK, the new bar will appear.

3. In the commands tab are available all the program commands, arranged by Categories
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4. Select the required command button and Drag and drop to the toolbar. To drag the command,
click over it with the left mouse button and keep it pressed

5. When the mouse button is over the toolbar, you can let go of the left mouse button
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6. The button will be added to the toolbar

 

7. To remove a button from the current toolbar, select the button and drag and drop it to the
commands list.

4.5.8.3 View - Toolbars and Docking Windows - Customize - Keyboard

This option allows you to create your one keyboard shortcuts. 

1. Select the Category and the Command to add the shortcut. 
2. Select the text box Press New Shortcut Key  and press keys to assign to add the shortcut.
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3. To remove the shortcut, select it and press Remove.

4. The button Reset All allows to set the original shortcut and delete the custom ones.
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4.5.8.4 View - Toolbars and Docking Windows - Customize - Menu

Application Frame Menus

Select the desired menu to reset from the "Show menus for:" 

After selecting the menu, press the Reset button, when you do that the menus will return to the
original state. 

Menu Animations 

It's possible to select animations for the menus.
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4.5.8.5 View - Toolbars and Docking Windows - Customize - Options

Enter topic text here.

Toolbar

Show Screen Tips on toolbars - Enable/ Disable the tooltips
   - Show shortcut keys in Screen Tips - This option is available only when the Show Screen Tips
on toolbars is enable.

Large icons - Select this option to see the icons larger.

Normal icons  Large icons
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4.6 View - Panel Tabs

This option shows all the options for displaying panel tabs.

4.6.1 View - Panel Tabs - Properties

This is the option to turn on/off the Properties panel tab.
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4.6.2 View - Panel Tabs - Last Properties

Use this option to change last technical parameters. It also allows to track the Last changes. 

To keep track of the last changes, press the button Set reference values 
From the moment the set reference values buttons is pressed, its possible to track where the last
was affected.

To undo the Last changes, press the button Restore the reference values , the last will return
to the initial parameters. 

In the Last Properties tab, it's also possible to change the Last Side, Last Size, Toe height, heel
height, Entry point distance and Entry line length.
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4.6.2.1 Last Properties

Before start the last edition, press Set Reference values button.

Change some of the last parameters. 

If you check the values in the columns Change and %, its possible to check what parameters
actually changed. 

This track of changes will work in any modifications made in the Last, for example modify by shape
or by section, etc. 

Press the button Restore to reference values, and the last will be restored to is original state. 
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4.7 View - Libraries

This menu allows to see the available library for MindCAD 3D Last and hide/show it.

4.7.1 Last Profile Templates

This library allows to save from current or open last profiles templates. 

Do a right click over the library area and to see the contextual menu:
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Import from the document - This option will import the last main templates lines (front line, heel
line, sole lateral, sole outline and top outline). 

Apply to document (auto) - The selected template is automatically applied to the current project.
 

Apply to document (manual) - The selected template is applied to the current project, allowing the
user to control the process.

Delete - The selected template(s) is deleted.

Rename... - Rename the selected template. 

Print... - Print the selected template(s).

Export... - Export the selected profile.

Cut - Cut the selected template(s).

Copy - Copy the selected template(s).

Paste - Pastes the template of the paste buffer (filled by cut or copy) into the current library.

Select all - Select all the templates from the current library.

4.7.1.1 Apply to document

To apply a last template to the current project:
- do a right click over the template and select Apply to document;
- or click and drag the template and release over the last. 

The red line represent the new Heel line, from template. And the black line, the original heel line,
from the last.
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Do a right click to access the contextual menu:

Finish - To apply the changes to the last

Cancel - To cancel the changes made. 

Move - Its possible to click and drag the new line, to better position. A feedback of the x,y
movement in mm is provided.

Scale - Allows to scale the line from template. Additional information about the line length is
provided. 
Click and drag the line ends.
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Rotate - Allows to rotate the line from template. A feedback of the angle is provided.
Approach the mouse cursor to the line end, click and drag the dialer to the desired rotation.

Reset original dimensions - The heel line from template, when placed into the Last automatically
adjust his size to the original line size. Select this option to reset the template line to his original
size.

Automatically adjusted line Original size

Enable snapping - Enable/disable the snap to the original line points. 
A visual feedback is provided, for an easier identification when this option is enable/disable. 

Snapping Enabled. Bullets in the line ends Snapping Disabled



89View Overview

© 2016 Mind - Software Multimedia e Industrial, SA

4.8 View - Status Bar

This is the option to turn on/off the status toolbar. It is recommended that this menu is displayed at
all times.

4.9 View - Layers

This option shows all the options for displaying layers.

4.9.1 View - Layers - Design

This is the option to turn on/off the design layer. This is the same as clicking the Design Mode

button  in the Layers toolbar.

The design layer is actually a combination of the other layers; it allows you to quickly set all the

required layers for designing.
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4.9.2 View - Layers - Preview

This is the option to turn on/off the preview layer. This is the same as clicking the Preview Mode

button  in the Layers toolbar.

The preview layer is actually a combination of the other layers; it allows you to quickly set all the

required layers to see a preview of the finished Last without the lines.

4.9.3 View - Layers - Design Helper Elements

This is the option to turn on/off the design helper elements layer.

Design helper elements are lines which are needed to give the designer more information about the
last. They normally are the centre line of the last at the back and front, the feather edge and island
(around the top of the last) lines.

Using the Design and Preview layer options, means that under normal circumstances this option is
not required.

4.9.4 View - Layers - Last Surface

This is the option to turn on/off the last surface layer. This is the same as clicking the Show/hide

last button  in the Layers toolbar.

4.9.5 View - Layers - Inner Sole

This is the option to turn on/off the preview layer. This is the same as clicking the Show/hide inner

sole button  in the Layers toolbar.

4.9.6 View - Layers - Platform

This is the option to turn on/off the platform layer. 

4.9.7 View - Layers - Lines

This is the option to turn on/off the lines layer. This is the same as clicking the Show/hide lines

button  in the layers toolbar.
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4.9.8 View - Layers - Points

This is the option to turn on/off the helper points layer. 

Points are positions on the surfaces with special significance, they will be specific to the current
last, and been added at the last digitizing stage. They include, vamp depth, back height, under ankle
heights and any others specified by the user when digitizing the last.

4.9.9 View - Layers - Markers

This is the option to turn on/off the markers layer. 

Markers are points placed on the last surfaces. They can be positioned when using the measure
options, they are displayed as red cones on the 3D surfaces.

4.9.10 View - Layers - Light Sources

This is the option to turn on/off the light sources layer.

The light sources can be modified using the options Light sources from Layers options in the View
menu.

4.9.11 View - Layers - Stencils

This is the option to turn on/off the Stencils layer. This is the same as clicking the Stencils 

button in the Layers toolbar.

Stencils are images that can be loaded into the background. The last and the stencil image can be

scaled and moved to become aligned. The billboard can have its intensity changed so that the image

is displayed over the last. Lines can then be drawn onto the last to imitate the image.

The Stencils toolbar is displayed when the layer is turned on.

4.9.11.1 View - Layers - Stencils - List

This option lets you select any opened stencil.
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Select the required stencil from the drop down list.

4.9.11.2 View - Layers - Stencils - Open

This option lets you open stencils.

This option will open a standard windows selection menu.

The stencil files can be of jpg, jpeg or bmp format.

4.9.11.3 View - Layers - Stencils - Delete

This option will delete the current stencil.

4.9.11.4 View - Layers - Stencils - Adjust

This option adjusts the transparency of the stencil.

Move the slider; the left side is less transparent, the right side is more transparent.

4.9.11.5 View - Layers - Stencils - Size and Position

This option lets you move and scale the stencils.

By default the tool move is the first to be activated.



93View Overview

© 2016 Mind - Software Multimedia e Industrial, SA

Align a 3D Stencil: 

Do a right click to access the contextual menu:

Finish: store current view settings in the selected stencil.
Cancel: to cancel the changes, and exit the tool. 
Move: Click and drag the desired axis (x,y,z), the stencil will move accordingly.

Scale: Click and drag the desired axis (x,y,z), the stencil will scale accordingly.
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Rotate: Click and drag the dialer to the desired rotation, feedback of the angle is provided

Align a 2D Stencil: 

To move the stencil:

1. Using the left mouse button, click and drag over the stencil. Move the mouse, the image
will move accordingly.

2. Release the mouse button to complete the operation.

To scale the stencil:

1. Hold down the CTRL key and using the middle mouse button, click and drag over the
stencil. Move the mouse to scale the image.
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2. Release the mouse button to complete the operation.

To rotate the stencil:

1. Hold down the CTRL key and using the right mouse button, two clicks to define the
rotation axis. Mode the mouse and the stencil will rotate accordingly. 

2. Other right click to complete the operation.

To finish adjusting the size and position right click and choose Finish.

When doing a right click anywhere on the screen the following options are available.

Finish: store current view settings in the selected stencil.
Adjust to window size: will resize the image to match the current viewport, keeping the original
aspect ratio.
Adjust to image real size: will return the image to its original size on screen.
Flip horizontal: flip the image horizontally
Flip vertical: flip the image vertically

4.9.11.6 View - Layers - Stencils - Set color

This option allows to define the stencils color. 

If you have more than one stencil open, you can assign different colors for each stencil.

The colors window will open, select the desired color and press Ok. 



96 MindCAD - Last Design & Engineering

© 2016 Mind - Software Multimedia e Industrial, SA

4.9.11.7 View - Layers - Stencils - Close

This is the option to close the stencils toolbar.
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5 Draw - Overview

This option shows all the options for drawing.

5.1 Draw - Line

This is the same as clicking the Draw Line  button in the Tools toolbar.

Use this option to draw lines over the last. By default the lines will be curved, but corners can be
added at any time.

Curved line

1. Select Line from the Draw Menu.

2. The cursor will be displayed as a cross 

3. Insert points on the last using the left mouse button. 

4. To finish the line either double click the left mouse button or press the right mouse button and
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select Finish from the menu.

Curved line with corner

1. Select Line from the Draw Menu.

2. The cursor will be displayed as a cross. 

3.

4. To add a corner either press Ctrl as you add the point,

5. Or when the cursor is in the correct position for the point, press the right mouse button and select 
Add Corner from the menu 
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.

6. The corner option can be used repeatedly in any line to create a zigzag effect.

Tips

use as few points as you can to create your desired curve.
avoid drawing across the cone and heel centre lines if possible, as these lines will not be give the
desired result when mirrored
use the snap functions in the constrain menu to keep lines (points) accurate.
use both 3D and 2D windows.

Line editing - Move point

1. Select Object selection from the Tools bar.

2. The cursor will be displayed 

.

3. Select the line to be edited.

4. As you approach a point on the selected line the cursor will change to a pen.

5. Press and hold down the left mouse button, as you move the mouse the point will move. To finish
the edit release the left mouse button.
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6. Repeat on any point on the selected line.

Line editing - Add/Delete point

To add a point to a line

1. Select Object selection from the Tools bar.

2. The cursor will be displayed 

.

3. Select the line to be edited.

4. Hold down the Shift button, approach the selected line between original points, the cursor will

change to a pen with a plus sign.

5. Press the left mouse button to add a point at this position.

To delete a point from a line

1. Select Object selection from the Tools bar.

2. The cursor will be displayed 

.

3. Select the line to be edited.

4. Hold down the Shift button, approach the point to be deleted, the cursor will change to a pen with

a minus sign.

5. Press the left mouse button to delete the point.

Line editing - Changing a Corner/Curve point

To change the corner/curve property of a point,

1. Select Object selection from the Tools bar.

2. The cursor will be displayed 

.
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3. Select the line to be edited.

4. Approach the point to be edited and get the pen cursor displayed.

5. Press the right mouse button and select the Change corner/curve option from the menu.
 

Line editing - Dragging/Scaling/Rotating a line(s)

Full information on Drag Constrain is in the Edit chapter. Click here for information on Drag
Constrain.

1. Select Object selection from the Tools bar.

2. The cursor will be displayed 

.
3. Select the line(s) to be edited.

4. With the pointed cursor displayed 

.
5. Press the left mouse button and hold it down to drag the lines.

6. Press the Ctrl button and the middle mouse button to scale the lines with the cursor

7. Press the Ctrl button and the right mouse button to select the rotation point. Then press the right
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mouse button to start rotation. Move the cursor to rotate the line(s) and another press of the left
mouse button will complete the operation.

5.2 Draw - Points

Use this option to place points over the last. 

The colour of this reference points can changed globally for new points under File - Preferences -
Editing - Reference Elements - Color dialog option. 

For further details please refer to File - Preferences - Editing section.

5.3 Draw - Continue Line

Use this option to continue drawing a line from another.

This option lets you add points to the ends of lines.
1. Select Continue line from the Draw menu. 
2. The cursor will be displayed as a cross

3. As you approach the end of a line the end will highlight

4. You can now add points to the end of the line using the left mouse button, finish the edit by double
clicking the left mouse button, or use the finish option in the menu displayed by clicking the right
mouse button.
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6 Tools Overview

This menu lets you take measurements between points on the last and along any lines

6.1 Tools - Measurements

These options let you take measurements between points on the last and along any lines.

6.1.1 Tools - Measurements - Free

This is the same as clicking the Free measurement  button in the Tools toolbar.

For measure the operator should:

1. Select Free from the Measurements options of the Tools menu.

2. Select a point on the last, using the left mouse button.

3. As you move the cursor the distance from the first point will be displayed.
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4. Click the left mouse button again to finish the operation.

While measuring, doing a right click the following options are available:

Finish - Finalize the measurement operation.
Straight Line - Measures the straight distance between two points. 
Set Value - Enter measurement value.
Free - No restriction in the measurement line length.
Select another line - Only available when doing measurements over a line.
Start line from here - Enables the curve drawing tool, starting a line from the measure end point.
Place marker here - Place a marker at the measure end point.
Place markers at start and finish - Place markers at both ends of the measure line.
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6.1.2 Tools - Measurements - Line

This is the same as clicking the Line measurement   button in the Tools toolbar.

For measure the operator should:

1. Select a line.

2. Select Line from the Measurements options of the Tools menu.

3. Use the mouse to select a point on the currently selected line.

4.  As you move the cursor, the distance from the first point, measured along the line will be
displayed, and the measurement highlighted.
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5. Click the left mouse button again to finish the operation

While measuring, doing a right click the following options are available:
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Finish - Finalize the measurement operation.
Straight Line - Measures the straight distance between two points. 
Set Value - Enter set measurement value.
Free - No restriction in the measurement line length.
Select another line - Only available when doing measurements over a line.
Start line from here - Enables the curve drawing tool, starting a line from the measure end point.
Place marker here - Place a marker at the measure end point.
Place markers at start and finish - Place markers at both ends of the measure line.
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7 Last Overview

In this menu is available the options to edit the Last and see is properties.

7.1 Last - References

This menu allows to adjust center and heel lines and to recalc girth.

7.1.1 Last - References - Adjust Center and Heel Lines

This is the same as clicking the Adjust Centre and Heel Lines  button in the Tools toolbar.

When selecting this option the current front and heel lines appears with special handles.
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The front and heel lines can be adjusted using the mouse by handling the red points. Careful
adjustment of those lines position is critical for division of inside and outside, leading to a proper
flattening.

You will have to reflatten your last for use in MindCAD 3D Design & Engineering

7.1.2 Last - References - Recalc Girth

This is the same as clicking the Recalc Toe Line  button in the Tools toolbar.

If by last editing, the area of the Toe Line is affected, there is the need to recalculate the Toe Line
(Girth Line). This process is fully automatic without user intervention.
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7.2 Last - Modify

In this menu is available several that allows to modify the Last, by parameters, shape, section,
surface and resurface.  

7.2.1 Last - Modify - By Parameters

Values

Stick Length
This option allows to change the value of the Stick length
Options

Lock toe spring and Heel height
If this option is activated when you change the stick length the toe and heel height will stay the
same.
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If this option is deactivated when you change the stick length the toe and heel height will also
change.

Lock Width
If this option is activated when you change the stick length the last width will stay the same.

If this option is deactivated when you change the stick length the last width will also change.

Lock Back
If this option is activated when you change the stick length the back width will stay the same.

If this option is deactivated when you change the stick length the back width will also change.
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Insole Length
This option allows to change the value of the insole length.

Girth Length

Options
Overal

By Width

By locking girth width

By locking cup height

Toe Height
This option allows to change the value of the toe height.
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Heel Height
This option allows to change the heel height.

Options
Heel seat length

The heel seat length doesn't change when
the Heel height is change.

Pitch Angle

Options
At Toe

At Heel

Show angle
Show height

7.2.2 Last - Modify - By Shape

This is the same as clicking the Adjust Shape  button in the Tools toolbar.
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Last section shapes can be edited using the following procedure

1. Do a right click and the above menu appears

2. To add internal Lines and edit them please choose one of the option internal Add Horizontal Line
or Add internal Vertical Line

Horizontal Line
As you move the mouse over the lines, they will
highlight.

To choose the line, clique over it. Now that line
can be edited.
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Vertical Line

3. Select Add nail or Remove nail with the mouse on the desired location over the profile line (if
Symmetric mode is enabled then a symmetric nail will be placed);
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3. Pick and drag the handle to be controlled, this will change the attached profiles limited by the
placed nails;

4. When finished, do a right click and choose Apply to Last
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5. Do a right click and choose Clear Nails

6. Do a right click and choose Finish 
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You will have to re-flatten your last for use in MindCAD 3D Design & Engineering

7.2.3 Last - Modify - By Section

This is the same as clicking the  Change Last by editing sections  button in the Tools
toolbar. 

This allows to modify the last by sections. 
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Press the button Previous section  or Next section  to navigate through the existing
sections. 

Press the button Edit section  to enter de edit current section mode. 

Press the button Delete  to delete the current section.

Press the button Create cross section  to create a new cross section.

Press the button Create heel section  to create a new heel section.

Press the button Create toe section  to create a new toe section.

Press the button Copy current section  to copy the current section.

Press the button Confirm changes  to apply the changes and close the tool.

Press the button Apply changes  to apply the changes and continue the edition.

Press the button Cancel changes  to cancel the changes and close the tool.

Active section info - Allows to check the area, length, height, width, Max. distance to original,
distance from heel and distance from toe, about the active section.

Toe/cross/Heel separation - Allows to define each section range. Define the toe distance and heel
distance, the cross distance will be the value in between. 

Display - Allows to control the Last view between is original state and the modified. It's possible to
define a color for the each state. 

Do a right click to access the contextual menu:
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Finish -  Allows to stop edition and close the tool.
Cancel - Allows to cancel all the changes and close the tool.
Apply changes - Allows to apply the changes and continue the edition.
Reset changes - Allows to cancel all the changes made.
New section - Allows to create a new cross, heel or toe section or to copy the selected section.
Delete section - Erase the selected section
Edit section - Allows to edit the selected section.
Reset section changes - Allows to cancel the changes made in the selected section.
Symmetric mode - Enable/Disable the symmetric edition mode. 
Free shape editing - Enable/Disable the free shape edition mode. 
Select next section - Allows to navigate through the existing sections
Deselect section - Allows to delete the selected section

7.2.3.1 Section Display

Allows to control the Last view between is original state and the modified.  

It's possible to define a color for each state. 

Click over the Original color button:
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The Colors windows will appear:

Select the color and press OK.

The button will change to the selected color. Do the same process for the Modified last color.

We define the original color as Blue and de modified color as Red. 

Move the slide bar to control what is displayed.

Only the original Last is visible.
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It's possible to see both, original 
and modified Last's.

Only the modified Last is visible.

7.2.3.2 Create a Section

Its possible to create as many section as required. 

To create a new section click in the create section buttons  on the edit last section
panel.

Or do a right click, select New Section on the contextual menu, and select one of the options:



127Last Overview

© 2016 Mind - Software Multimedia e Industrial, SA

The user can create section in three different areas of the last:

Cross - Heel - 

Toe - 
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In alternative it's also possible to copy an existing section:

Select the desired section, by clicking over it.

To copy the section click in the Copy current section button , or do a right click and select the
option Copy current under the New section option, from the contextual menu. 

The copy will be made, the new section is placed exactly over the original.
To move the copied section, place the mouse cursor over the section, until the red arrows feedback
is given,
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then just click and drag to see both section.

7.2.3.3 Edit a Section

Select the section to edit, by clicking over it, by using the Previous section  or Next section
 or clicking in the Space bar, to navigate through the sections.

To move the section, place the mouse cursor over the section, until the red arrows feedback is given,
then just click and drag to move the section.

In alternative its also possible to control the section positioning in the Edit Last Section bar.

For cross sections: 

For heel section: 

For toe section: 

To start the edition, click over the selected section again or click the button Edit section .
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Place the mouse cursor over the section area to edit.

Click over the section and drag.

To edit both sides symmetrically, keep SHIFT pressed and click and drag the section, or do a right
click and active the Symmetric mode from the contextual menu.

To apply the changes press the button Apply changes , or do a right click and select Apply
changes from the contextual menu.
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7.2.3.3.1  Section templates Editor

1. In the Edit Last Template context, do a right click to open the context menu and select 
Templates, under the new section options.

2. The section templates editor window will open.
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3. Now its possible to create a new template from the current configuration, click in the button 
Create from current configuration. 

4. The new section template will appear. Click over it to access the other options. 
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Apply - to apply the selected template to the model. 
Rename - To edit the selected template name. 
Delete - To delete the selected template.
Close - To close the Section Templates Editor window.
Preview - Shows a template preview. 

5. Its possible to have several templates. 



135Last Overview

© 2016 Mind - Software Multimedia e Industrial, SA

7.2.3.4 Free shape editing

Free shape edition mode allows to edit the section point by point. 

To active this option, select the section,

do a right click and select Free shape editing from the contextual menu.
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To the section line, will be added more edition points.

It's possible to add more points, or remove points.
To add new points, hold down the Shift button, approach the section line between the original points,

the cursor will change to a pen with a plus sign.
Press the left mouse button to add a point at this position.
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To delete a point, hold down the Shift button, approach the point to be deleted, the cursor will

change to a pen with a minus sign.
Press the left mouse button to delete the point.

7.2.4 Last - Modify - By Surface

This is the same as clicking the Adjust Grid  button in the Tools toolbar.

Last section shapes can be edited using the following procedure:
1. Select points to edit, press left button down and while pressing, do a circular movement

encompassing the handles you want to include/exclude. If you do this movement anti-clockwise,
handles will be included, if clockwise handles will be removed.
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Note: You can remove all the selected handles by doing right click and choosing Clear Selection. 

2. Do a right click and the contextual menu appears:
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3. Before starting to adjust the handles themselves, there are two axis systems to choose from:
Orthogonal Axis System - all the changes of the handles will be based on axis referenced to the
Cartesian space
Normal UV Axis System - all the changes of the handles will be based on an axis system derived
from normal to surface of the selected center and last grid directions.

Just do a right click and choose accordingly.

4. Moving of the centre from where the affectation will be calculated is also possible by doing a right
click and choose Move Center.
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Now drag the coordinate system to the desired location.

5. Do a right click and choose Adjust points. When clicking on the axis coordinate, the selected
handles will be translated by a certain amount (by default this will be 1 mm). If a different amount
is needed, just right click and choose Define Offset. If the operator prefers to use the arrows keys
on the keyboard, the corresponding axis should be blocked by doing a right click and choosing 
Lock Axis;

In alternative you can also control the points on the adjust surface toolbar. 

6. Do a right click and choose Free Adjust. Now click and drag the point  freely to the desired
position.
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7. Whit a previous 3D stencil loaded, select the point to adjust.

a. Do a right click and choose Stencil - Adjust Points from the contextual menu.
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b. The selected points will adjust to the stencil form. 

 
Use Set Adjust Distance option to define the adjust margin between the last and the stencil. 
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8. While moving the handles, the surface will be pulled out or pushed in with blending parametrized
by the Affectation Type: 

All Equal -  all the handles are affected by the same offset value.
Linear - the handles are affected based on a linear distribution where maximum affectation is on the
centre and minimum on the boundary of the convex hull of the handles.
Quadratic - as in Linear but with a Quadratic distribution.
Sinusoidal - as in Linear but with a Sinusoidal distribution.

9. To commit changes to the last surface, do right click and choose Apply To Last and Clear
Selection for better evaluation of the result.

You will have to re-flatten your last for use in MindCAD 3D Design & Engineering.

10.Doing a right click and using the options under Rows and Columns menus, refinement of the grid
is possible. Just select the scope of the grid to be refined.
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Choosing Rows - Add

Rows will be inserted between the selected nodes.
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Choosing Columns - Add

Columns will be inserted between the selected nodes.
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7.2.5 Last - Modify - By Resurface

This is the same as clicking the Resurface  button in the Tools toolbar.

This option should be used when there is the need to repair wrong surfacing or when if last surface
editing procedures were extreme to the point where the current patchwork in no longer appropriate for
rigorous representation and control.

7.2.6 Last - Modify - Bottom Heel Symmetry

1. Select Bottom Heel Symmetry from the Modify options of the Last menu.
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2. Choose the symmetry limit points (red point). The symmetry points can only be placed in the
intersections between the original line (green line) and the mirrored line (dashed red line). Each
intersection is marked with a black dot.  

3. To change the symmetry limit points position, do a left click over the new position.

4. The point will be changed, and the new line (yellow line) will be rearranged accordingly. The yellow
line is the average between the current line (green line) and the mirrored line (dashed red line).

5. Do a right click to access the contextual menu:

Select finish to close the tool and apply the changes, or cancel to close the tool with no changes. 
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7.3 Last - Boot Leg

This option allow boot leg modifications on the original last from small adjustments to full feature boot
leg construction.

7.3.1 Last - Boot Leg - Clip

Use this option to adjust the top of the last by plane clipping. To achieve this, the user must control
this clipping plane by two handle points constrained to the toe line and to the heel line.

When satisfied with the cutting plane position, right click and choose Finish. A new last is
generated with the top properly clipped.
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7.3.2 Last - Boot Leg - Raise

Use this option to vertically raise the top of the last by a specific amount.

After selecting this option a dialog appears
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Enter the height of the material to be vertically added and press OK

A new last is generated with the added material. Since the material is added vertically without control
of the blend region, it is possible to smooth the transition by using the Adjust Shape tool.

7.3.3 Last - Boot Leg - Shell

This is the same as clicking the Make Boot Upper  button in the Tools toolbar.

After activation of this button, a wizard is launched, guiding the creation of the bootleg
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1. Select the values and click finish.

2. After selecting this option, a parameter dialog and a 2D schematic boot leg diagram is displayed.

3. This dialog displays information of Last Size, Width Key and Toe Line Length (Girth Length).
Only when all the construction process for the entire boot is done, should the finish button be
pressed.

4. The user could set new values for Heel Height. Press Apply to propagate this change to the 3D
model.

5. The user can import lines (eg. DXF format) as reference lines and use them to draw the shape of
the boot leg.
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6. While importing, the user can use the edit adjustment tools (rotate, scale, flip horizontal and
vertical). When finishing adjustment procedures, the user should press Finish button to confirm
import operation.

7. Centre the imported bootleg interactively. Press SHIFT for automatic snapping. Choose Finish
when properly positioned.
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8. The bootleg lines will adjust to the imported reference lines.

9. For specialized modelling, several functionalities are available through the Boot Construction
toolbar.
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10.Select Draw boot control line button . Besides the default construction lines, the user
could create as many others horizontal control lines as needed, by simply using the cursor to
specify their initial height position.

11.Select Delete boot control line button  for deleting horizontal construction lines.

12.Select Show/Hide base last lines button  to toggle visibility of base last lines.

13.Select Show/Hide auxiliary lines button  to toggle visibility of auxiliary lines.

14.While hovering the cursor on control lines, information about its alignment, width, height and
distance to auxiliary lines will be displayed. Please note, these distances to auxiliary lines are
strongly dependent on alignment type.

15.The user can parametrically change these values invoking the property dialog. Select the line,
press the right mouse button and choose Object Properties.
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16.The user can adjust the both blending points, namely Front separation point and Heel separation
point.

17.Finally, press the Finish button, the user allows the creation of the equivalent 3D boot model.
This boot could be edited at any stage by selecting pressing Make boot upper button on the
Tools toolbar.
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7.3.4 Last - Boot Leg - Revert to Shoe

Use this option to revert to the original last before boot leg transformations using the Make Boot
Upper option.

7.4 Last - Grading

This is the same as clicking the Last Grading  button in the Tools toolbar.

This option lets you create a graded last.

1. Select the option a menu is displayed
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2. The user can grade the last by specifying table values increments (Stick length, Girth length) and
number of sizes. 

3. After changing those values press Apply and the resulting last is previewed.

4. Choosing Finish to generate a graded last replacing the original working last.

You will have to re-flatten your last for use in 3D Design & Engineering

7.5 Last - Flattenings

This menu allows to create and manage the last flattenings.
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7.5.1 Last - Flattening - Flatten Uper

This is the same as clicking the Flatten Upper  button in the Tools toolbar.

 

This option lets flatten the upper surface of the last.

1. Select Flatten Upper from the Flattening options on the Tools menu and a dialog is displayed.

For further information, please refer to Last - Flattening - Flattenings Manager.

2. Select OK and the flattened halves will be displayed.
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3. By default the halves will be displayed with the digitised vamp point as the vamp depth. If this is
the correct position move to step 7.

The vamp depth can be changed by selecting the Change Vamp Depth  button in the Merging
toolbar.

If selected a cross is displayed 

 which slides up and down the centre line, move to the required position and click the left
mouse button.

4. Now select the Align Vamp Depth  button in the Merging toolbar.

This will align the two halves at the new vamp depth and put them back on the fold line which is
displayed.

5. Select the Mean Lines  button in the Merging toolbar.

A menu is displayed
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Select the lines to be meaned and select OK

The halves will be displayed with the lines ‘meaned’

6. Select the Mean feather  button in the Merging toolbar.

A menu is displayed
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Enter four points to define the parts of the feather edge which are to be meaned. Always work from
the heel to the toe along the feather edge.

Point 1 (symmetrical from heel) will define how far forward from the heel curve the two feather edge
lines will be the same.

Point 2 (Blend point) will define where the two feather edge lines are in their natural position on the
inner and outer halves, blended from point one.
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Point 3 (Blend point) will define where the two feather edge lines are in their natural position on the
inner and outer halves, blended from point four.

Point 4 (symmetrical from toe) will define how far back from the toe the two feather edge lines will be
the same.
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After the four points have been entered the halves will be modified and displayed

7. Select the Rotate  button in the Merging toolbar.

Click the left mouse button on the background

Move away from the first mouse click and click the left mouse button again, now when you move the
mouse the halves will rotate about the vamp point.

Rotate to the desired ‘spring’ and press the left mouse button again to stop the rotation process.
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8. Select the Straighten Centre Line  button in the Merging toolbar.

The centre line from the vamp point to the toe will be straightened.

If you do not use this option the flattening will be left with an open toe (sometimes this is required).



165Last Overview

© 2016 Mind - Software Multimedia e Industrial, SA

9. Select the Flip  button in the Merging toolbar.

The flattening will be unfolded.

Flattening can be left in the folded sate by not using this option.

10.The flattened patchwork can be displayed for checking and editing. Editing is not recommended,

to do this select the Display Patchwork  button in the Merging toolbar.
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To edit points, select the Select  button in the Merging toolbar.

Using the left mouse button click on the half you wish to edit. All points on that halve will be
displayed as small squares.



167Last Overview

© 2016 Mind - Software Multimedia e Industrial, SA

As you approach the point(s) to be edited the cursor will change into a pencil. Click the left mouse
button and hold it down, move to the new position for the point and release the left mouse button.

11.Select Save And Exit from the File menu to save your flattening.

Other options in this menu are:
Cancel - Cancel and close the flattening process.
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Export - Export to several 2D formats:

Import - Import from several 2D formats:

Print… – Print the shell.
Print Preview… – Print Preview of the shell.
Printer Setup…– Print setup for the printing.

7.5.1.1 Last - Flattening - Adjust spring

1. Select outside or inside lines and select the Adjust Spring   button in the Merging toolbar.
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2. Select the area to rotate. Finish with Double Click.

3. Select the center of rotation and rotation. 
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3. With right button, select Confirm, Redefine Area or Cancel. 

7.5.1.2 Last - Flattening - Mean Heel Line

1. The image below shows the original flattening of the last.

2. Select the Mean Heel Curve  button in the Merging toolbar.
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A menu is displayed

3. Select the Use Radius option to enter a radius for the heel curve, the curve; the curse will be fitted
between the bottom of the heel curve and the digitised back height.

4. Select the Use 3D Back Line option and press OK. 
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5. The flatted back line will be replaced by the 3D back line. 

Top Clip and Bottom Clip:

Values for Top Clip and Bottom Clip can also be added to tip the heel curve in or out, at either the
back height (top clip) or where the heel curve meets the feather edge (bottom clip).

Negative values will shorten the flattening, and positive values will make the flattening longer (you can
use a combination of positive and negative values on the two options).
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7.5.1.3 Last - Flattening - Import Shell Lines

The image below shows the original flattening, before the importation process begins.

1.  Select the file type from the Import option on the File menu. In this example the file type is
BGD.

2. Select the appropriate file and click Open. The lines will be imported.

3. Select the imported flattening position,right click and select Finish.
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4. To replace the new imported shell for the old one, with the new shell selected, go to Tools menu
and select the option Replace Contour.

5. The below window will appear.

6. Select where you want to replace the contour.



175Last Overview

© 2016 Mind - Software Multimedia e Industrial, SA

7. Following the lines name that appears in the Line selection window, start selecting the lines. First
select the Feather line from the imported lines, using the left mouse button .

8. Select the Front Line.

9. Select the Top Line.
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10.Select the Heel Line.

11.After the conclusion of the importation process, the flattening lines are now adjusted to the
imported ones.
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7.5.1.4 Last - Flattening - Free draw

This option allows adjusting a flattening by replacing a line. 

1. The original last flattening:

2. Select the Draw Line option, from Tools menu and draw a line.

3. In the Tools menu, select the option Replace Contour Line.

4. Select the line to be replaced.
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5. The line is now replaced for the new one.

7.5.1.5 Last - Flattening - Distortion Map

Allows to active the layer distortion color map and  control the parameters. 

1. To active the distortion map visibility, select Show/hide from Distortion Map option under the
View menu. 
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2. The distortion map is active allowing to check the distortion areas between the 2D and 3D. 

3. To configure the distortion color map, select Config... from Distortion Map option under the View
menu.
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Type - Select the type of distortion between:
Area - The difference between 2D and 3D area. 
Distance - The difference between 2D and 3D perimeter (by zones).

Scale - Select the scale between:
Dynamic scale - Scale is based in the real last range values.  
Static scale - The scale is defined by the user.

Colors - Select the color for each distortion zone. 
Max - If the 3D value is bigger that 2D. (by default Red)
Zero - If the 3D and 2D values are equal. (by default white)
Min - If the 3D value is smaller that 2D. (by default blue)

7.5.2 Last - Flattening - Flatten Bottom

This is the same as clicking the Flatten Bottom  button in the Tools toolbar.

This option flattens the bottom surface of the last.

1. Select Flatten Bottom from the Flattening options on the Last menu, a menu is displayed.
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2. Select Flattening method; if different from your default method, see Misc tab in Preferences
options in File menu.

3. The flattened patchwork can be displayed for checking and editing. Editing is not recommended,

to do this select the Display Patchwork  button in the Merging toolbar.

Use the left mouse button click to edit. All points on that halve will be displayed as small squares.
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As you approach the point(s) to be edited, the cursor will change into a pencil. Click the left mouse
button and hold it down, move to the new position for the point and release the left mouse button.

4. Select Save And Exit from the File menu to save your flattening.

Other options in this menu are 

Cancel - cancels the flattening process

Export - to several 2D formats
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Import - from several 2D formats

Print… – Print the shell.

Print Preview… – Print Preview of the shell.

Printer Setup…– Print Setup for the printing.
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7.5.3 Last - Flattening - Flattenings Manager

This menu will allow you to open the Flattenings Manager:

To create a new flattening template:

Go to the Last - Flattenings - Flattenings Manager menu and choose New on the Flattening
Manager (image above). You'll be presented with the dialog box below:
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On the Generic tab:

Insert the new flattening name. 

Choose the Surface to Flatten: Upper Split (medial and lateral flattenings),  Full Upper or Bottom.

If the surface to be flattened is Full Upper, you'll need to specify where the surface breaks: heel
line or center line or user defined.

Select the flattening Method: The available flattening methods will vary depending on the surface
you chose to flatten 

Choose material Thickness: the larger the value the bigger the flattened halves will be. The value
you use will depend on material to be lasted, personal preference for tightness of upper to last,
etc. It is recommended to start by trying a 0 thickness and adjusting the value from this know start
point.

On the Adjustments tab:

Front Length and Feather length: when these options are selected it's possible to adjust the
front and bottom lines, for the 2D stick with the same lengths that 3D. If the option is active, it's
possible that the lengths stay exactly the same (when the value is 0); the difference can be
controlled by the user (nonzero value).

Inside toe line adjustment and Outside toe line adjustment: The user can defined the toe line
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adjustment, it's possible that the lengths stay exactly the same, in both 2D and 3D (when the
value is 0); the difference can be controlled by the user (nonzero value).

Force boot contour: This option is only available in boots flattening. The intent of this option is to
adjust the flatten lines to the 2D contour that appears at the time the boot was created. If this
option aren't checked the flatten result will be different from what is seen in the 2D window to upper
the boot.

Line smoothing: This option allows to smooth the flatted lines result.

Note: If the Flattening Method is either Progressive Grid or Progressive Grid 2, you'll be able to set
the number of Vertical and Horizontal Patches used in surface subdivision (a new Parameters tab
appears when these Flattening Methods are selected). 
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8 Window Overview

This menu lets you control the position and way your windows are arranged on the screen.

8.1 Window - New Window

This option opens another window.

8.2 Window - 1x1

This option closes all the other windows of the selected document, except one, that will be
maximized.
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8.3 Window - 2x2

This option show four windows of the selected document and organize them 2x2.

8.4 Window - List

Select the name of a current window to make it active.
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9 Applications Overview

This menu lets you switch to other MindCAD applications.

9.1 Applications - MindCAD 3D Design & Engineering

This option lets you switch to the MindCAD 3D Design & Engineering package.

 MindCAD 3D Design & Engineering lets you:

create your 3D designs
create 3D parts
create or import soles
visualise your finished shoe.

9.2 Applications - MindCAD 2D Design & Engineering

This option lets you switch to the MindCAD 2D Design & Engineering package.

MindCAD 2D Design & Engineering lets you create your 2D patterns with allowances, notches,
text etc. They can then be graded and output to a cutter for production.
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10 Help Overview

This menu lets you launch the help system, open the Mind web site and display the version number
of the current software.

10.1 Help - Help Topics

This option lets you launch the help system.

10.2 Help - Mind on the Web

This option lets you open the Mind website (http://www.mindtech.com.pt/).
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10.3 Help - About MindCAD Last Design & Engineering

This option displays a dialog containing the version number and licensing information.
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11 Libraries

The library system in MindCAD LAST Design & Engineering allows to open, create and delete
library folders. 
There are one main top level nodes:

the <default> is the folder where built-in elements delivered on installation of the software package
resides;

Child of the node <default> are the user libraries, customized in an hierarchy controlled by the end
user. The operator is then able to organize library folders based on client, season, ... based on
personal or enterprise policies.

11.1 Library - New

This option allows for the creation of library folders.

1. Click on the folder icon  in the left side of the libraries and the library manager window will
open.

2. Right click on a node, for example the <default> node and some options appear. Select the New
Sub Library option.

3. Write the desired name and press Ok.
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4. The new library folder is created.

11.2 Library - Open

This option allows to open a library folder

In this example, the <default> library folder is displayed by default

1. To open another folder, simply click on the folder icon  in the left side of the libraries and the
library manager window will open.

2. Select the Camp template library. Press Ok.
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The displayed library folder now is the "camp template".

11.3 Library - Delete

This option allows to delete a library folder.

1. Click on the folder icon  in the left side of the libraries and the library manager window will
open.

2. Right click over a folder and select Delete.
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11.4 Library - Rename

This option allows to rename a library folder.

1. Click on the folder icon  in the left side of the libraries and the library manager window will
open.

2. Simply right click over a folder and select Rename.

11.5 Library - Filtering and Sorting

To access the filtering and sorting functionality, there are two button on the left. 

This option allows to search a library folder. Just activate this button and write the name to search. 

The search is always using an implicit wildcard matching algorithm that will be any element with "1"
in the name, no matter its position. The update of the underlying thumbnails is immediate.
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This option allows to sort alphabetically. Press twice to cycle through ascending, descending and
no sorting modes.

On these buttons, there is a small square box on the right bottom side that indicates if the
functionality is enabled (green) or disabled (red).

11.6 Library - Pane Settings

To access the Pane Settings click on the icon   in the left side of the libraries and the library
manager window will open.

The follow window will appear.

Size - To change the size of each item in the libraries
Min - Define the minim size 
Max - Define the maxim size
Scrollbar location minimize footprint - Enable/disable this option to change the scrollbar

location vertical/horizontal.
Spacing - The space between each item in the libraries

X - To change the space along the X axis
Y - To change the space along the Y axis
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Border - To customize the border of each item in the libraries
Color - Allows to change the color of the border of each item in the libraries
Thickness - Allows to change the thickness of the border of each item in the libraries

Labels
Show Label - Enable/disable the label of each item in the libraries
style - To change the labels style

Font - Change the labels font
Color - Change the labels color

Show tooltip - Enable/disable the tooltips of each item in the libraries
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